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Socket menu commands

The Socket menu offers the following commands:

Enumerate_Protocols Displays the protocols available.
Enumerate_Namespace_Providers Displays the namespaces available.
Get_Host Identifies the host IP address or name.
WinSock_Details Displays information on the WinSock library in use.
Exit Exits Analyze



UDP menu commands

The UDP menu offers the following commands:

Send Datagram Send a UDP datagram.
Echo_Datagrams Echo all UDP datagrams received.
BOOTP Send a BOOTP request to the specified server.
DNS Lookup Perform a DNS name lookup.
UDP_Datagram_Receive Receive UDP datagrams.
DHCP Issue a DHCP request to the specified server.



IP/ICMP menu commands

The IP/ICMP menu offers the following commands:

Receive Receive IP Messages.
Broadcast Send an IP message to the broadcast address.
Ping Send an ICMP Ping message to the specified address.
Traceroute Trace the route to a specified address.
Get_Time Obtain the time from the specified host.
Get_Subnet_Mask Obtain the subnet mask from the router.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status_Bar Shows or hides the status bar.
Options Default settings for port addresses, network type etc.



Display menu commands

The Display menu offers the following commands.

Hex_Dump Displays the data in hexadecimal format.
Interpret_Dgram Interprets the contents of a datagram.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help_Topics Offers you an index to topics on which you can get help.
About Displays the version number of this application.



Control menu commands

The Control menu offers the following commands.

EnterReceiveMode(Once) Enters receive mode for one datagram after 
issuing the command..

EnterReceiveMode(Cont) Enters receive mode continuously after 
issuing the command.

StopOperation Stops receiving.



Enumerate Protocols (Socket menu)

This command displays the protocols available through the WinSock 2 interface.



Get Host (Socket Menu)

Determines the host address from the host name, or vice versa. The host address is specified in the Host Name 
Dialog Box.



Enumerate Namespace Providers (Socket menu)

This command displays the naming services provided by the service provider.



 WinSock Details (Socket Menu)

Display the version of WinSock in use,and the manufacturers description.



Receive (IP/ICMP menu)

Listen for and display IP messages.



Broadcast (IP/ICMPmenu)

Send an IP message to the broadcast address. If the listening ear is shown next to the menu item, the program 
will enter receive mode after sending the broadcast message.



Ping (IP/ICMP menu)

Sends the ICMP Echo Request message and listens for a reply. The timeout for the reply to be received is set in the 
Options Dialog Box.



Network Type
Enter the type of network (Physical media). This is used in some IP messages and datagrams to specify the type of 
the MAC address



OK
Confirm and save the changes made



Cancel
Cancel any changes made



Port Assignments
The UDP ports used for various protocols and services may not be found in the services file. If not, the defaults 
entered here are used.

If the Force use of these ports button is checked, then the spcified port will be used, even if the system can resolve 
the port number through the services file or other method.



Port Number
Enter the UDP or TCP port number corresponding to the service.



Force Use of These Ports
If this button is checked, the specified port will be used even if the port number could be resolved by other means.



Sound
If this button is checked, a warning beep is sounded when a message or datagram is received.



Ping Timeout
The number of seconds to wait for a reply to an echo request (ping). The same timeout is used by traceroute.



Traceroute (IP/ICMP menu)

Determine the route taken to reach a given host.



Get Time (IP/ICMP Menu)

Obtain the time from the specified host.



Get Subnet Mask (IP/ICMP menu)

Obtain the subnet mask from the router. If no router is available the command may fail.



Exit command (Socket menu)

Use this command to end your Analyze session.    You can also use the Close command on the application Control 
menu. 

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Send Datagram (UDP menu)

Send a UDP Datagram to the specified host and port. Data may be entered in the dialog box. If the host address is 
specified as the broadcast address then the datagram will be broadcast.

If the listening ear symbol is displayed against the menu item, the program will enter receive mode immediately 
after sending the datagram.

The host address and message are specified in the Host Name and Data Dialog Box.



Echo Datagrams (UDP menu)

Echo any datagrams received on the specified port.



BOOTP (UDP menu)

Send a BOOTP request to the specified server, and display the results. If an alternative MAC address is entered in 
the dialog box, the reply for that MAC address will be displayed. (This relies on the BOOTP server being able to 
broadcast it’s replies)

The BOOTP server name and network adapter address are specified in the the Host Name and MAC Address Dialog 
Box.



DHCP (UDP menu)

Send a DHCP request to the specified server, and display the results. If an alternative MAC address is entered in the 
dialog box, the reply for that MAC address will be displayed. (This relies on the DHCP server being able to 
broadcast it’s replies)

The DHCP server name and network adapter address are specified in the the Host Name and MAC Address Dialog 
Box.



DNS Lookup (UDP menu)

Perform a DNS lookup on a specified host running the DNS services. The types of query which may be made are:

A Host Address
CNAME Canonical Name
HINFO Name of CPU and Operating System
MINFO Mailbox information
MX Mail Exchanger
NS Name Server
PTR Pointer
SOA Start of Authority
TXT Text

The host address, query and type are specified in the DNS Dialog Box.



Enter Receive Mode (Once) (Control Menu)

After a datagram or message has been sent, automatically enter receive mode for one message. This allows the reply 
to be displayed.

Note that when this option is in operation, the listening ear is displayed alongside the menu item for all applicable 
commands.



Enter Receive Mode (Cont) (Control Menu)

After a datagram or message has been sent, automatically enter receive mode continuosly. This allows multiple 
replies to be displayed.

Note that when this option is in operation, the listening ear is displayed alongside the menu item for all applicable 
commands.



Stop Operation (Control Menu)

When an operation is started to listen for a message or datagram, that message may not arrive, and the program 
remains listening. Because an operation is in progress, most of the menu items are greyed out. This option allows 
such a command to be interrupted.



UDP Datagram Receive (UDP menu)

Listen for and display UDP datagrams from the specified host and port. The host address is specified in the Host 
Name and PortDialog Box.



IP ADDRESS
Enter the dotted quad IP address of the host e.g. 192.168.49.34



Host Name
Enter the host name e.g. www.microsoft.com



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands 
in Analyze such as Help.    A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar provides quick 
mouse access to some tools used in Analyze

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Go to the previous record in the current selection.

Go to the next record in the current selection.

Display version details.

Display help file.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected 
menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when 
the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Analyze window.    To display or hide the status bar, use the Status 
Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. 
This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing 
them.    If after viewing the description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Options (View menu)

This command displays the Options Dialog Box, which allows details about the network and environment to be set.



Hex Dump (Display menu)

Sets the display to Hex Dump format.This may be useful for examining messages which cannot be interpreted by 
Analyze. 



Interpret Dgram (Display menu)

In this display mode Analyze will display received messages and datagrams by interpreting the data according to the 
type of message received.







 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to step-by-step 
instructions for using Analyze and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Analyze



Context Help command 

Use the Context Help command to obtain help on some portion of Analyze    When you choose the Toolbar's Context 
Help button, the mouse pointer will change to an arrow and question mark.    Then click somewhere in the Analyze 
window, such as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:

Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document.    You can use the mouse to scroll to other parts of the 
document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you 
want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow 
keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.







Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document Control 
menu closes only one window at a time.    You can close all windows at once with the Close command on the File 
menu.

Shortcuts
Keys: ALT+F4 closes the Analyze window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize 
command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an application 
on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not affect 
applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect applications reduced 
to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Options Dialog Box



Options Dialog Box

The Options Dialog Box



Host Name Dialog Box



Host Name Dialog Box

The Host Name Dialog Box



MAC Address
Enter the unique ID of your network adapter e.g. 00:A0:73:24:0A:72



Host Name and MAC Address Dialog Box



Host Name and Data Dialog Box



Data

Enter the message string to be sent in the datagram.



DNS Dialog Box



DNS Query
Enter the query to be made e.g. www.microsoft.com



Query Type
Enter the type of DNS query to be made.



Hostname and Port Dialog Box



Port Number
Enter the number of the UDP port to receive on.



Previous Record
Display the previous message or datagram received.



Next Record
Display the next message or datagram received.




